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Instructions for Use of This Packet:

e The punctuation shown here is not optional. Punctuation is an important part of MLA standards and
should be followed precisely as it is seen here.
Any explanatory notes are found in [ ] behind the item being explained. The information in the
brackets should not be directly copied into the entry.




Author’s Last Name, Author’s First Name. Title of Book. City of Publication: Publisher, Copyright Year.
Print.

Author Variations: (Book examples are shown here but the concept applies to other entry types as well)

One Author:

Castro, Elizabeth. Creating a Web Page with HTML. Berkeley: Peachpit Press, 2005. Print.

Two Authors:

Riddle, John, and Rae Simons. Veterinarian. Broomall: Mason Crest Publishers, Inc., 2003. Print.
More than Two Authors:

Booth, Wayne C., et al. The Craft of Research. Chicago: University of Chicago Press, 2003. Print.

Editor — No Author (common in reference books)

Editor’s First and Last Name, ed. Title of Book. City of Publication: Publisher, Copyright Year. Print.
Example of Editor — No Author:

Brunner, Borgna, ed. Time Almanac 2006. Boston: Information Please, 2005. Print.

No Author — No Editor:

Title of Book. City of Publication: Publisher, Copyright Year. Print.

Example of No Author — No Editor:

Hammond World Atlas. Italy: Hammond World Atlas Corporation, 2000. Print.

Corporate Author:

Name of Corporation, Association, Committee, or Group. [omit “a”, “an”, or “the”] Title of Book. Ed.
Editor(s)’ First and Last Name(s). [if given] City of Publication: Publisher, Copyright Year. Print.

Example of Corporate Author:

US News and World Report. What College Really Costs. Ed. Margaret Mannix. Naperville: Sourcebooks,
Inc., 2005. Print.




<> BOOKS FOR CONTROVERSIAL ISSUES

(See specific examples from the library collection that follow)

Author’s Last Name, Author’s First Name. “Title of Article.” Title of Original Source Publication Date of
Original Source. Rpt. in Title of Book. Ed. Editor(s)’ First and Last Name(s). Title of Series. City of
Publication: Publisher, Copyright Date of Series. Page Number(s). Print.

Contemporary Issues Example:

Paige, Sean. “Professional Athletes as Role Models.” Insight on the News 3 Aug. 1998. Rpt. in Professional
Sports. Ed. James D. Torr. Examining Pop Culture. San Diego: Greenhaven Press, 2003. 171-180.
Print.

Opposing Viewpoints Example:
Leshner, Alan 1. “Addiction is a Brain Disease.” Issues in Science and Technology Spring 2001. Rpt. in Drug
Abuse. Ed. Tamara L. Roleff. Opposing Viewpoints. Detroit: Greenhaven Press, 2003. 68-77. Print.

Current Controversies Example:

Kelling George L. “Aggressive Policing Does Not Encourage Police Brutality.” Wall Street Journal 23 Mar.
1999. Rpt. in Police Brutality. Ed. Louise I. Gerdes. Current Controversies. San Diego: Greenhaven
Press, 2004. 74-77. Print.

At Issue Example:

English, Brian J. “Threats to Coral Reefs Face Many National and Human Threats.” Threats to Coral Reefs

2000. Rpt. in Are the World’s Coral Reefs Threatened? At Issue. Detroit: Greenhaven Press, 2005. 39-47.
Print.

Reference Shelf Example:

Slater, Eric. “Monterey Bay Canoys is a Role Model.” Los Angeles Times 10 Aug. 2004. Rpt. in U.S. National
Debate Topic 2006-2007: National Service. Ed. Ronald Eniclerico. The Reference Shelf. New York:
The H.W. Wilson Company, 2006. 131-36. Print.




<> WORK IN AN ANTHOLOGY
Author’s Last Name, Author’s First Name. “Title of the Essay, Short Story, Poem, or Work.” Title of the

Anthology. Ed. Editor(s)’ First and Last Name(s). [if given] City of Publication: Publisher, Copyright
Year. Page Number(s). Print.

Example:
Keats, John. “Ode to a Grecian Urn.” The Norton Anthology World Masterpieces. Ed. Maynard Mack.
New York: W.W. Norton and Company, 1995. 821. Print.

% MULTIVOLUME SOURCE OR ENCYCLOPEDIA
Author’s Last Name, Author’s First Name. [This is the author of the article — found at the beginning or end of

the article — if given] “Title of Article.” Title of Book. Ed. Editor(s)’ First and Last Name(s). [if given]
Vol. Volume Number. City of Publication: Publisher, Copyright Year. Page Number(s). Print.

Example:
Mastrandea, Michael D., and Stephen H. Schneider. “Global Warming.” World Book Encyclopedia. Vol. 8.
Chicago: World Book, Inc., 2003. 232-32b. Print.

X ARTICLE IN A SINGLE REFERENCE BOOK
Author’s Last Name, Author’s First Name. “Title of Article.” Title of Book. Ed. Editor(s)’ First and Last

Name(s). [if given] City of Publication: Publisher, Copyright Date. Page Number(s). Print.

Example:
Hamm, Richard F. “Common-Law Court.” The Oxford Companion to the Supreme Court. Ed. Kermit L. Hall.
New York: Oxford University Press, 1992. 171. Print.

% INTRODUCTION, PREFACE, FOREWORD, AFTERWORD,
JACKET COVER, EMBEDDED TEXT, OR QUOTATION
Author’s Last Name, Author’s First Name. [author of the passage] Type of Passage. [types listed above] Title

of Passage. [if applicable] By Author of Book. [or editor if author isn’t given] City of Publication:
Publisher, Copyright Year. Page Number(s). Print.




Example:
Cowley, Malcolm. Introduction. The Stories of F. Scott Fitzgerald. Ed. Malcolm Cowley. New York: Charles

Scribner’s Sons, 1951. vii-xxv. Print.

X ARTICLE IN A MAGAZINE
Author’s Last Name, Author’s First Name. “Title of Article.” Title of Magazine Publication Date: Page
Number(s). Print.

Example:
Schneider, Karen S., et. al. “A Sobering Decision.” People 6 Nov. 2006: 48-51. Print.

X ARTICLE IN A NEWSPAPER
Author’s Last Name, Author’s First Name. “Title of Article.” Title of Newspaper Publication Date: Page
Number(s). Print.

Example:
O’Neil, Tim. “Officials Expect Long Lines at the Polls.” St. Louis Post-Dispatch 2 Nov. 2006: A6. Print.

s ARTICLE IN ASCHOLARLY JOURNAL

Author’s Last Name, Author’s First Name. “Title of Article.” Name of Periodical Volume Number. Issue

Number (Publication Year): Page Number(s). Print.

Example:
Chang, Patricia. “What’s next for Iraq?(After the U.S. leaves).” The Christian Century 126. 8 (2009): 23.
Print.

X3 PAMPHLET
Sponsor of Pamphlet. Title of Pamphlet. Place of Publication: Publisher, Year. Print.

Example:
Bureau for At-Risk Youth. Violence. Huntington: 1994. Print.




X SPEECH OR LECTURE
(Possibly by One of Your Esteemed Teachers)

Speaker’s Last Name, Speaker’s First Name. “Title of Speech or Lecture.” Sponsoring Organization. City,
State Where Speech or Lecture was Delivered, Date of Speech or Lecture. Form of Delivery [Address,

Lecture, Keynote speech, or Reading]

Example:
Bickel, Rich. “The Illustrious and Adventurous History of the U.S. Foreign Service.” O’Fallon Township
High School. O’Fallon, IL, 8 Nov. 2006. Lecture.

> PUBLISHED INTERVIEW

Last Name of Person Interviewed, First Name of Person Interviewed. Name of Person Conducting Interview.

[include the words “Interview with”] Title of Source. Source’s Publication Date: Page
Number(s).Medium of Publication [Print, Radio, DVD, Television] .

Example:
Streisand, Barbra. Interview with Oprah. O, The Oprah Magazine. Oct. 2006: 296-99+. Print.

X INTERVIEW (conducted by you)
Last Name of Person Interviewed, First Name of Person Interviewed. Personal Interview. [Could also be

“Telephone Interview” or “E-mail Interview”] Date Interview was Conducted.
Example:
Wilson, Robert. Personal Interview. 16 April 2006.

<> MAP or CHART

Title of Map or Chart. Description. [use the word “Map” or “Chart”] City of Publication: Publisher, Date of

Publication.
Example:
Michigan. Map. Chicago: Rand, 2000.




< MOVIE REVIEW FROM PRINT SOURCE
Rev. of Title of Movie, by First and Last Name(s) of Reviewers. Title of Source Date of Publication: Page
Number(s). Print.

Example:
Rev. of Talladega Nights: The Ballad of Ricky Bobby, by Richard Brody. The New Yorker 6 Nov. 2006: 5.
Print.

Electronic Sources

A WORK FOUND ONLY ON THE WEB

When citing a source from the World Wide Web, the following pieces of information should be included in
the citation. If not all information is available, cite what is given.

Name of Author [Last name, First name]

“Title of Work”

Title of overall Website

Publisher or Sponsor of the site; if not available, use N.p.

Date of Publication [Day, Month, Year] ; if not available, use n.d.

Medium of Publication [Web]

Date of Access [Day, Month, Year]

s WEBSITE

Example:
Lessig, Lawrence. "Free Debates: More Republicans Call on RNC." Lessig 2.0. N.p., 4 May 2007. Web. 15
May 2008.

% ARTICLE FROM AN ONLINE NEWSPAPER

Example:

Achenbach, Joel. "America's River." Washington Post. Washington Post Company, 5 May 2002. Web. 20

May 2002.

s ARTICLE FROM AN ONLINE MAGAZINE ACCESSED ON THE WWW

Example:

Levy, Steven. "Great Minds, Great Ideas.” Newsweek. Newsweek, Inc., 27 May 2002. Web. 30 June 2003.




% COPYRIGHTED IMAGE FROM AN ELECTRONIC SOURCE

Example:

Brandio, Flavio Cruvinel. Swallow-tailed Hummingbird. Flickr Yahoo! Inc., 16 Nov. 2006. Web. 13 Dec.
2006.

Note: Titles of images are italicized, not put in quotation marks.

% MOVIE/FILM REVIEW FROM A WEBSITE

Example:
Orndorf, Brian. “ ‘Rush Hour 3’ Tired, Yet Still Wild Fun.” OhmyNews On Screen. OhmyNews, n.d. Web. 17
Aug. 2007.

Citing Resources Accessed on the Web or in a Database
after being Published in Print

Note: Refer to the print template for the initial citation information. Then include the
following three components to indicate the online medium:
1. Title of Database or Website

2. Medium of Publication [Web]
3. Date of Access [ Day, Month, Year]

% AN ARTICLE FOUND IN A DATABASE
Stone, Andrea. "White House Hopes Volunteer Initiative Will Help Economy." USA Today 19 June 2009: A2.
Opposing Viewpoints. Web. 29 July 2009.

« ONLINE BOOK - QUESTIA
Hamburger, Michael, and Christopher Middleton, eds. Modern German Poetry, 1910-1960. New York:
Grove Press, 1962. Questia. Web. 5 Dec. 2006.

<+ ARTICLE FROM AN ONLINE SCHOLARLY JOURNAL IN A DATABASE
Chang, Patricia. “What’s next for Iraq?(After the U.S. leaves).” The Christian Century. 126. 8 (2009): 22.
Student Resource Center — Gold. Web. 7 July 2009.




Citing Resources Accessed on the Web or in a Database
after being Published in a Non-Print Medium

Note: Refer to the print template for the initial citation information. Then include the
following three components to indicate the online medium:

1. Title of Database or Website
2. Medium of Publication [Web]
3. Date of Access [ Day, Month, Year]

< VIDEO CLIP
West, Kanye. Amazing. 2009. YouTube. YouTube, LLC. n.d. Web. 8 Feb. 2009.

Note: Titles of video clips are italicized, not put in quotation marks.

Citing Other Specific Resources

Note: There will be some instances in using Gale’s Infotrac databases and United
Streaming where previous publication information does not apply. In these cases, the
database is the original source of publication.

The following pieces of information should be included in the citation. If not all information is available,
cite what is given.

1. Name of Author [Last name, First name]

2. “Title of Work”

3. Title of overall Website

4. Publisher or Sponsor of the site; if not available, use N.p.

5. Date of Publication [Day, Month, Year] ; if not available, use n.d.

6. Title of Database or Website

7. Medium of Publication [Web]

8. Date of Access

UNITED STEAMING
Biologix: The Central Nervous System and Brain. Discovery Education. Discovery Communications, LLC.
1997. United Streaming. Web. 29 July 20009.




Other Media Sources

% PAINTING, SCULPTURE, OR COPYRIGHTED IMAGE FROM A PRINTED SOURCE

Creator’s Last Name, Creator’s First Name. [if given] Title of the Work. [not all images will have an official

title, so substitute a descriptive title, such as Rainforest Image, but do not underline that title] Name of
the Institution or Individual that Owns the Work. [if given] Title of the Source. By Author’s First and
Last Name. [if given] City of Publication: Publisher, Copyright Date. Page Number(s).

Example:

Oliver, Isaac. Self-Portrait. National Portrait Gallery. 500 Self-Portraits. London: Phaidon Press Limited,
2000. 111.

< SONG

Performer’s Last Name, Performer’s First Name. [if given] “Title of the Song.” By Composer’s First and Last
Name. [person who wrote the song] Title of the Album. Name of Manufacturer or Production
Company, Copyright Date. Medium [Audiocassette, CD, or LP].

Example:

“Requiem Lacrimosa Dies Illa.” By Wolfgang Amadeus Mozart. Essential Classics: 50 Classical Highlights.
St.Clair Entertainment Group Inc., 2005. CD.

> VIDEOTAPE OR DVD

Title of Tape or DVD. Dir. Director’s First Name and Last Name. Production Company, Year Produced.

Medium. [Film, DVD, videocassette, slide program, or filmstrip]
Example:
Global Warming: The Signs and the Science. Dir. Michael Taylor. PBS Home Video, 2005. DVD.

<> TV SHOW OR RADIO PROGRAM

“Segment’s Title or Episode’s Name.” Title of Program. Station’s or Network’s Name, Place of Production.

Date of Broadcast. Medium of reception [radio or television].
Example:
“Teenage Spending.” 60 Minutes. CBS, New York. 3 Nov. 2005.Television.




Appendix A:

Answers to Frequently Asked Questions About MLA Style

. WHAT DOES MLA STAND FOR? Modern Language Association

. HOW MANY SPACES FOLLOW PERIODS AND COLONS IN AN ENTRY?
e One Space Example: The dog ate my homework. Really?

. HOW DO | FORMAT THE WORKS CITED PAGE?
Do not number entries or use bullets.

All items are double spaced. No single spacing anywhere.
Each entry ends with a period.

Use a hanging indent for each entry that goes beyond one line. All lines after the first line are indented 1
tab.

Titles that are not in quotation marks must be italicized. Check with your teacher. Be consistent.

Alphabetize by the author’s last name or the first important word of the title. (See Question 4)

4. HOW DO | ALPHABETIZE ON THE WORKS CITED PAGE?
e Titles that start with numbers are first—in numeric order.

If there is no author, alphabetize by the first important word of the title. Do not alphabetize using
“The,” “A.,” or “An”, but do not remove these words from the title.

If the same author wrote two or more of the sources you are using, type ---. instead of writing the
author’s name the next you enter it on the page. See the sample Works Cited page for an example.

5.HOW DO | WRITE AUTHOR NAMES ON THE WORKS CITED PAGE?
One author: Jones, James.
Two authors: Jones, James, and Harry Smith.
More than two authors: Jones, James, et al.
Name with a middle initial: Jones, James W.
Name with a title, such as Dr.: Do not include the title.

NOTE: If no author is given, the entry will begin with the editor’s name and will use the same format for
authors shown above. This applies to both print and electronic information.

6. HOW DO | WRITE PAGE NUMBERS ON THE WORKS CITED PAGE?
NOTE: Page numbers should only be used for electronic documents (such as Website articles) if the pages you are viewing on
the screen are numbered. DO NOT use printer-generated page numbers found on the upper right corner of your printout.

e A source on page 4:
4

e A source on pages 4 through 12:




4-12
e A source starting on page 4 and continuing later in the book or magazine:
4+
7. HOW DO | WRITE DATES ON THE WORKS CITED PAGE?

A. Month & Year
e Abbreviate the Month (except May, June, and July)
Examples: Jan. Feb. Mar. Apr. Aug. Sept. Oct. Nov. Dec.

Do not use a comma between month and year
Example: Sept. 2006

B. Full Date
e Include Day Month Year — in this order
Example: 15 Aug. 2004

8. WHAT’S THE DIFFERENCE BETWEEN A WORKS CITED PAGE AND A BIBLIOGRAPHY?

Works Cited Page:

Provides the reader, or your teacher, with a list of all the resources or works that you cited within the
text of your paper, the contents of your speech, or within your project.

Bibliography:
A complete list of all the resources that you consulted or used in some way while putting your paper,
project, or speech together, even if they were not actually cited in the paper, project, or speech.

ANSWERS TO OTHER FREQUENTLY ASKED QUESTIONS

1. WHAT IS THE DIFFERENCE BETWEEN CITING A WEBSITE ARTICLE AND AN ARTICLE
FROM A SUBSCRIPTION DATABASE LIKE GALE?

Website Article from a Publicly Available Website:

Usually lower-quality research and, therefore, generally not recommended because the information is
not guaranteed to be accurate or unbiased and is unlikely to have been reviewed by experts. This isa
Website that anyone can view and that anyone could have created, such as Wikipedia.org.

Website Article from a Site Requiring a Subscription or Registration:

Information may be a little higher in quality but is still unlikely to have been reviewed by an expert and
could be biased or inaccurate. However, the site may have a strong reputation for quality, such as
CNN.com.

Subscription Database Article:

Higher-quality research because the information is paid for and goes through a quality control process
that often includes review by authority figures in a specific field of knowledge. Information is written
by scientific researchers or experts in a particular field of knowledge.




2. WHAT SHOULD I DO WHEN A WORK CITED ENTRY FLOWS OVER TO THE NEXT PAGE?
It is better for the reader to see a work cited entry in its entirety, so use the Enter key to move all lines
of the entry to the next page, even if this leaves a gap at the bottom of the previous page.




Appendix B:
General Formatting Specifications for MLA Style

Paper
e Use 8 % x 11 in. white paper.
e Print on one side of the paper only.

Margins
e 1”on all sides
e Set the margins of the paper under “File” => “Page Setup” before starting to type.
e Do not justify your margins on the right side of the page.

Font
e Choose an easily readable typeface (e.g. Times New Roman) and 12 pt. font for all typing.
That includes the body of the paper, title, heading, and works cited page.

. Spacing
e The entire document is double-spaced. That includes the body of the paper, title, heading, and
works cited page.
e Before you start typing, set the document to double spacing.
1. Select “Format” => “Paragraph”
2. Under “Line Spacing” select “Double” from the drop-down menu
NOTE: If you’ve already started the document, highlight the text and follow steps 1 and 2.

Heading
e A 4-line heading is on the first double-spaced line following the page number. The heading is
typed in the upper-left corner of the first page of the paper.
The 4-line heading consists of:
(Line 1) Student’s First and Last Name
(Line 2) Teacher’s Name
(Line 3) Course Name
(Line 4) Date [Day Month Year]
e MLA does not require a title page.
e The heading is not bolded or underlined.
e The heading is double-spaced.

6. Title
e Follows the 4-line heading.
e Is double-spaced like the rest of the document
e IsNOT bolded OR underlined OR “in quotes” OR italicized
e Is centered on the page.

7. Paragraphs
e The first line of each new paragraph is indented 1 tab.




8. Page Numbers

Numbered consecutively throughout the paper through the works cited page(s), which are the
last pages of the paper.
Placed in the upper right-hand corner of all pages.
Contain the student’s last name, one space, and then the page number.
Are set up on the document’s first page in the document’s header.
1. Go to “View” => “Header and Footer”
2. When the Header box appears at the top of the page, tab over to right side of the box.
3. Type your last name. Then, hit the spacebar one time.
4. In the Header and Footer box that appears on the screen, click on the first icon (a piece
of paper with a # on it). This will automatically place the numbers on your pages for

you.
Close the Header and Footer box.




!

lin. Student’s Name Appendix Yin.
C __1<
A /
Lynn Smith Page Number

Instructor’s Name
in Header

Mr. Elfrink

*/////// Class
Spanish Il Title: No bold, no underline,

5 Dec. 2006 «— Date: Day Month Year / no italics

Indent 1 tab The Art of Spanish Cuisine

lin.

T~ When thinking of Spanish cuisine, does Taco Bell come to mind? How aboutthe «——

<«—>|ocal Mexican restaurant on the corner? To many in the Spanish world, the art of Spanish

lin.

cuisine remains a revered and deeply rooted part of one’s culture. Recipes pass from

generation to generation, creating a lineage of Spanish cuisine. From ingredient selection
to the finest details of preparation and presentation, the art of Spanish cuisine proves to
be a part of Spanish culture that deserves recognition and further understanding.
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Page Number
in Header
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Appendix D
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